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Thank you for purchasing the CX1000.  This operation guide briefly explains the main
operations related to the loop control function of the CX1000.  For information about all

the functions excluding the communication functions, installation and wiring procedures,
operating procedures, and handling precautions of the CX1000, see the electronic
manual CX1000 User’s Manual (IM 04L31A01-03E) provided on the accompanying CD-

ROM.  The following four manuals are provided in addition to this manual and the
CX1000 User’s Manual.  Read them along with this manual.
Electronic Manuals Provided on the Accompanying CD-ROM

Manual Title Manual No. Description

CX1000/CX2000 IM 04L31A01-17E Describes the communication functions of the
Communication Interface CX1000 using the Ethernet/serial interface.
User’s Manual

DAQSTANDARD for IM 04L31A01-61E Describes the functions and operating procedure
CX User’s Manual of the software “DAQSTANDARD for CX” that

comes with the package.

Paper Manuals

Manual Title Manual No. Description

CX1000 Installation and IM 04L31A01-73E Describes concisely the installation procedures
Connection Guide and wiring procedures of the CX1000.

Precautions on the Use IM 04L31A01-72E Precautions regarding the use of the CX1000/
of the CX1000/CX2000 CX2000.

Note
• This manual provides information on the CX1000, style number “S3.”
• The contents of this manual are subject to change without prior notice as a result of

continuing improvements to the instrument’s performance and functions.

• Every effort has been made in the preparation of this manual to ensure the accuracy
of its contents.  However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA dealer as listed on the back cover of this manual.

• Copying or reproducing all or any part of the contents of this manual without the
permission of Yokogawa Electric Corporation is strictly prohibited.

• The TCP/IP software of this product and the document concerning the TCP/IP

software have been developed/created by YOKOGAWA based on the BSD
Networking Software, Release 1 that has been licensed from the Regents of the
University of California.

Trademarks
• Microsoft, MS-DOS, Windows, and Windows NT are either registered trademarks or

trademarks of Microsoft Corporation in the United States and/or other countries.

• Zip is either a registered trademark or trademark of Iomega Corporation in the United
States and/or other countries.

• Adobe and Acrobat are trademarks of Adobe Systems incorporated.

• Company and product names that appear in this manual are trademarks or registered
trademarks of their respective holders.

Revisions
1st Edition April, 2002
2nd Edition January, 2003
3rd Edition June, 2003

Disk No. RE37

3rdd Edition : January 2003 (YK)

All Rights Reserved, Copyright © 2002 Yokogawa Electric Corporation
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Introduction to Control Functions
For further details on each function, see chapter 1, “Explanation of Functions” in the

CX1000 User’s Manual (IM 04L31A01-03E) provided on the accompanying CD-ROM.
Control Types

Control Mode
Three control modes are available.

PIDSP

PV

OUT

PIDSP

PV1 PV2

PID

OUT

PIDSP

PV1 PV2

OUT

Single-loop control Cascade control Loop control with PV switching

PV: Process value
SP: Target setpoint
OUT: Control output

Analog retransmission

Output comes from 
the control output 
channels per the 
results of the 
specified equation. 

Control Operation Mode
You can specify either of the following control operation modes for each control output
terminal block.  However, program control operation can be specified only on models
with the program control option.

• Fixed-point control (program control OFF): Set the SP locally or use remote input
• Program control operation: Set the SP locally or use program patterns

PID Control Function
Control Computation Types and Control Output Format
You can select from time proportional PID control (voltage pulse/relay output),

continuous PID control (current output), or On/Off control (relay output).
Control Direction
You can select the direction in which OUT changes according to the polarity of the

deviation between the SP and the PV.
• Reverse action (PV > SP: OUT decreases, PV < SP: control output increases)
• Direct action (PV > SP: OUT increases, PV < SP: control output decreases)

PID Control Mode
You can select the change in the operation when the SP is changed.
• Follow-up: Controlled so that the output reaches the new SP quickly

• Fixed-point: Suppresses sensitive reaction of the output to change to the new SP
PID Control Method
One of the following methods is automatically selected depending on the PID control

mode and the control operation mode.
• PV derivative type: Control method in which the control output is kept from

changing radically when the SP is changed by a great

amount
• Deviation derivative type: Control method in which fast response to follow the SP is

emphasized

Control Parameter (“PID Parameter” in the Settings)
You can set up to eight groups of control parameter sets for each loop.  Control
parameters include SP, PID constant, control output limiter, manual reset value, control

direction, and preset output.
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PID Parameter Selection Method
You can select the method for switching PID parameters from the following:

• Target setpoint selection: By specifying the SP number.
• Zone PID selection: By dividing the measurement span in to multiple zones and

determining in which zone the PV resides.

• Segment PID selection: Using the program pattern segment when in program
control.

Tuning
There are two methods: auto tuning of PID constants using the limit cycle method, and
manual tuning that allows PID parameters to be set individually during operation.

Control Suppression Function
Anti-Reset Windup (Over-Integration Prevention)
Overshoot may occur if the deviation between the SP and PV continues for an extended
time and the control output reaches the output high-limit through the integration process.

To prevent this from happening, the anti-reset windup function is used to pause the
integration process when the manipulated output reaches the high limit of the output
limiter.

Stop PID
computation

Start PID
computation

Output
value

PV

Time

Time

100%

Output
high limit

0

SP

Overshoot Suppression Function (“Control Output Suppression” in the Settings)
The deviation is monitored to detect the danger of overshooting and automatically
changes the SP to a slightly lower tentative value referred to as the “auxiliary target
setpoint” and continues control.  Then, when the process value enters a range in which

overshooting is no longer a danger, the auxiliary target setpoint is gradually returned to
the original SP.

Original SP

Start fuzzy logic

Time

PV

PV

Auxiliary SP

Control output
suppression function On

Control Output Limiter
You can set high and low limits of the control output range (”output high-limit/low-limit” in
the settings) regardless of the operation mode.

Shutdown
This function is used to close the control value fully (set the output to 0) exceeding the
dead band of the control valve positioner.

Output Velocity Limiter
This function is used to prevent radical changes in the control output to protect the
control element and object of control.

Control Function Introduction
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Preset Output
This function sets the control output to the preset value when the operation is stopped.

SP Ramp-Down-Rate/SP Ramp-Up-Rate
This function is used to decrease or increase the setpoint at a constant rate of change
(as opposed to a rapid change) when the SP is changed.

Target Setpoint Limit
This function is used to limit the range of values that the SP can change.

Tracking Function
You can set the following two tracking functions to suppress a radical change in the
output.
SP tracking: When switching from remote to local operation mode, the output is tracked

to the remote SP immediately before the SP switching.
PV tracking: The SP is matched to the PV at that point and then returned to the original

value according to the target setpoint ramp-up rate or the target setpoint

ramp-down rate.

Control Alarm Function
You can set up to four alarms for each loop.  The following alarm types can be specified.
PV upper-limit alarm, PV lower-limit alarm, deviation high limit alarm, deviation low limit
alarm, deviation high/low limit alarm, deviation high and low limits alarm, SP high limit

alarm, SP low limit alarm, output high limit alarm, and output low limit alarm.

Control Function Introduction
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Wiring
Input/Output terminals are arranged on the rear panel of the CX1000 as shown in the

figure below.  The figure shows the case when option terminals are specified on the
model with 6 internal control loops and 20 measurement channels (CX2620).  For the
wiring procedure of the control/measurement input/output, see chapter 2, “Installation

and Wiring” in the CX1000 User’s Manual (IM 04L31A01-03E) or the CX1000 Installation
and Connection Guide (IM 04L31A01-73E).  For a description on the connection of
communication interfaces such as the serial or Ethernet interface, see the CX1000/
CX2000 Communication Interface User’s Manual (IM 04L31A01-17E).

L N

Control/measurement input
terminal block

Control output terminal block

Option terminal block

or

Controllers (up to 4 loops)
100 VAC to 240 VAC
24 VDC/AC (/P1 option)

R1

6 universal measurement inputs

Select one from the following option terminal blocks.

PLC
(such as the FA-M3
by YOKOGAWA)

PC

CX1000

5 universal measurement inputs

• Universal control output: for 2 loops
 Select current, voltage pulse, or
 relay output.
• Control contact input: 6 inputs

• Control contact input
 Relay output: 2 outputs
 Transistor output: 4 outputs

LAN
(Ethernet)

SSRMagnet
switch

Contact
input
6 inputs

Contact
output
6 outputs

Measurement alarm
output + remote input/

output (/A6R option)

Measurement alarm output +
FAIL/memory end output

(/A4F option)

Measurement alarm
output + FAIL/memory
end output + remote 

input/output (/A4FR option)

Measurement alarm output
(/A6 option)

Control Terminal Arrangement of the Control/Measurement Input Terminal Block
(Conceptual Diagram)
The following figure denotes the three terminals (/b, +/A, -/B) of a single column of
control input terminals using a single cell.

LOOP2
2 1 3 2 1

PVPV (RSP)(RSP)

(RSP)

(RSP)

PVPV

PV1PV1 PV2PV2

LOOP1

+
A

-
B

5

+
A

-
B

4

+
A

-
B

3

+
A

-
B

2

+
A

-
B

1

+
A

-
B

6

b b b b bb

Measurement input terminalsControl input terminals

During single-loop control
During cascade control
During loop control with
PV switching

[Control mode setting]

PV, PV1, PV2: PV input, (RSP): RSP input
(not used during program control),    : unused terminal

Terminal Arrangement of the Control Output Terminal Block

LOOP1
NO
NC
C

NO
C

2
NO
NC
C

LOOP2

CTRL OUT

mA
PULS

C

LOOP2
mA
PULS

C C

5
6

C

3
4

4
5
6

1
2
3

LOOP1

CTRL OUT

DIGITAL OUT DIGITAL OUT DIGITAL IN

NO
C

1

Contact
input

Transistor
output

Relay contact
output

Control relay
contact output

Control current
voltage pulse
output
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Overview of Operations
Key Operation

For details on the key operation, see chapter 3, “Names of Parts, Display Modes, and
Common Operations” in the CX1000 User’s Manual (IM 04L31A01-03E).

DISP/
ENTER

MENUESCFUNCUSERSTART STOP

Select the value or execute the operation
that is displayed in soft key menu

Start/Stop data
acquisition to
the internal
memory and
waveform display

Switch between operation mode and setting mode

Switch from setting mode to
basic setting mode or display
possible functions in operation
mode in the soft key menu

Cancel an operation

Execute the
assigned
action

Confirm the value
or operation

Select parameters or move the cursor

Switching Operation Modes
There are four operation modes: operation mode, control setting mode, common and

measurement setting mode, and basic setting mode.

Power ON
Operation mode

Common and measurement setting mode
[Set mode]

Basic setting
mode

MENU key

Menu

Operation display

Setup display
(#1 to #11)

Setup display
(#1 to #12**)

Menu

MENU key or ESC key

Soft keys MENU key or
ESC key

Soft keys ESC key

[End] soft key -> DISP/ENTER key
(This operation saves the settings made
in the basic setting mode.)

Control setting mode
[Setting mode (Control)]

Menu

Setup display
(#1 to #8*)

Press the FUNC
key for 3 s

Soft keys MENU key or
ESC key

ESC key

MENU key

* #1 to #9 when program control
 is ON.

** #1 to #11: Basic common and
  measurement settings
 #12: Basic control settings

Display Transition Diagram

Press the FUNC
key for 3 s

Switching Displays during Operation Mode
You can change the operation display according to your needs by carrying out the
following procedures.

DISP DISP

Display selection menu

Operation
display

Sub menu

DISP  indicates the DISP/ENTER key.  indicate the arrow keys.
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Control Operation Display
In operation mode, the following control operation displays can be selected.
• Control group display

This display is used to monitor the control status of multiple loops simultaneously
including external loops.  You can select from three display styles as shown in the
display example in the figure below.  If you include the measurement channels for the
measurement function in the group, you can also monitor the measured values on
the measurement channels at the same time on this display.

• Tuning display
This display is used to optimize (tune) the control parameters such as PID constants.

• Overview display
This display is used to monitor the alarm status of all control loops.

• DI/DO status display
Displays the ON/OFF status of the current contact input (DI) and contact output (DO).

• Control action summary display
Displays a log of control actions such as operation run/stop and auto/manual
operation switching.

• Internal switch status display
Displays the ON/OFF status of the internal switch.

On models with the program control function option, the following additional displays are
available: 1) the program operation status display, which can show the pattern and
current PV accumulated on the screen during program operation and 2) the program
event summary display, which shows a log of time events and PV events that occurred
during program operation.
Displays common with the measurement function include: 1) the alarm summary display,
which shows a log of alarm occurrence status and 2) the memory summary display,
which shows the file information of the internal memory.
In addition, on the trend display of the control function, the PV, SP, OUT can be assigned to
virtual channels (control channels), and the trend of control status can be displayed like the trend
waveforms of measurement channels on the trend display of the measurement function.

• Control group display

Faceplate style Hybrid styleController style
• Tuning display • Overview display

• Control operation summary display • Trend display

Display Examples

• DI/DO status display

• Internal switch status display

Overview of Operations
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List of Control Setup Items
Basic Control Setup Items in Basic Setting Mode
#1 Control action

PID number, control period, zone PID, restart mode, restart mode (program) (only on
models with the control option), initial PID, auto tuning, control mode, method (only
during loop control with PV switching), program control ON/OFF (only on models with
the program control option), and PID control mode.

#2 Input setting
Burnout and RJC.

#3 DI/DO/SW-registration
Contact input registration

#4 AUX
Remote setting, alarm mode, SP number selection source, PV/SP math, and CLOG
error.

#5 Output processing
Control output, cycle time, and analog-output type

#6 Relay
FAIL ON/OFF, self diagnosis ON/OFF, and relay action/behavior (energize/de-
energize, hold/nonhold)

#7 Tuning setting
Tuning item selection

#8 External loop setting (For details on the settings, see the CX1000/CX2000
Communication Interface User’s Manual (IM 04L31A01-17E).)

Setup Items in the Control Setting Mode
#1 Control input range

Input type, mode, type, range, span, scale, unit, square root, low-cut, bias, filter, and ratio.
#2 Control alarm

Type, standby, relay output ON/OFF, and alarm value
#3 Operation-related parameters/Zone PID

Suppressing function, ramp-rate-time unit, SP ramp-down-rate/SP ramp-up-rate, tag,

tag comment, reference point (when zone PID is selected), switching hysteresis
(when zone PID is selected), and reference deviation (when zone PID is selected).

#4 PID parameters

SP, PID constant, output limit, shutdown ON/OFF, manual reset, relay hysteresis
(only during ON/OFF control), reverse/direct, and preset output.

#5 Control group setting

Group name, kind (internal loop/external loop/measurement channel), and number.
#6 Ten-segment linearizer I/O

Input type, mode, and biasing or approximation input/output values.

#7 Program control (only when program control is ON)
#1 Program parameter setting

Pattern initial setting, wait action setting, program start setting, program pattern

setting, event setting, and repeat action setting.
#2 Event output setting

Event kind, relay output ON/OFF, number, and program pattern end signal relay

output ON/OFF.
#3 AUX (Auto message, Display position)

Auto message for program Run/Reset and Program display position.

#8 Detailed setting (“#7” when program control is OFF)
#1 Control function

SP tracking, PV tracking, SP limiter, output velocity limiter, and anti-reset windup

auto/manual.
#2 Hysteresis (Alarm and PV event)

Alarm hysteresis and PV event hysteresis

Overview of Operations
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Examples of Control Setup Operation
Control Setup Example 1: Single Loop Control

Object of Control and Description

CX1000

DISP/
ENTER

1
2
3
4

SSR

Electric
furnace

TC LOOP1 PV1

LOOP1 PULS2

DIGITAL OUT13

DIGITAL OUT23

1 Loop 1 PV input terminal
of the control input terminal block

2 Loop 1 voltage pulse output terminal
of the control output terminal block

3 Relay contact output terminal
of the control output terminal block

High limit temperature alarm

Low limit temperature alarm

Voltage-pulse
control output

PV
Alarm output

• Loop number: 1

• PID constant: P = 5%, I = 240 s, D = 60 s
• Control direction: Reverse
• Input type: TC K type

• Measurement span: 0 to 1200°C
• Output type: Voltage pulse (cycle time: 3 s)
• Temperature setpoint: 700°C

• Alarm output: PV high-limit alarm (high limit: 800°C), PV low-limit alarm (low
limit: 600°C)

Basic Control Settings
1. From the operation display, open the basic control setting menu according to the

following procedure.
Press the MENU key (to switch to Set mode), then hold down the FUNC key for 3 s

(to switch to basic setting mode).  Press the Next 1/4 soft key, followed by the Next
2/4 soft key, and then the #10 soft key (to select Control).

Press [Next]
twice

Menu (Setting mode (Control)) Menu (Basic setting mode 1/4)

Menu (Basic control setup menu)Menu (Basic setting mode 3/4)
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2. Press the #1 soft key (Control action, Input setting).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft

key of each value according to the following figure, and then press the DISP/ENTER
key.

Select 1

Select Single
(single loop)

Select Temp
(Set initial PID to P = 5%,
I = 240 s, and D = 60 s)

4. Press the ESC key to return to the basic control setting menu.
5. Press the Next 1/2 soft key, and then the #5 soft key (Output processing).

6. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure, and then press the DISP/ENTER
key.

To set Cycle time, press the Input soft key to open a numeric entry pop-up window.
Enter the value using the arrow keys and the DISP/ENTER key.

Select 1

Set to 3 s

Select Voltage-pulse

* No need to set 
  Analog-output type

7. Press the DISP/ENTER key to confirm the settings.

8. Press the ESC key twice to return to the menu display (basic setting mode 3/4).
9. Press the Next 3/4 soft key to show the menu display (basic setting mode 4/4).
10.Press the End soft key.

A confirmation window shown below opens.

11.Press the DISP/ENTER key to confirm the settings.

Examples of Control Setup Operation
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Setting the Control Input Range in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu

shown below.

2. Press the #1 soft key (Control input range).

3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value, and press the DISP/ENTER key.
To set the measurement span (span lower/upper-limit), press the Input soft key and

use the numeric entry pop-up window that opens.
Select 1

Select TC

Select K

Select PV1

Set to 0.0

Set to 1200.0

Press the arrow keys to select these keys
and then press the DISP/ENTER key

Move between digits

Confirm the entry

Numeric entry pop-up window

4. Press the DISP/ENTER key.
A confirmation window shown below opens.

5. Press the DISP/ENTER key to confirm the settings.

Examples of Control Setup Operation
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Setting Control Alarms in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu.

2. Press the #2 soft key (Control alarm).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft

key of each value according to the following figure.

The numeric value of the alarm is entered using the pop-up window that appears by
pressing the Input soft key.

Select 1

Set to 600.0
Set to 800.0

Select DO002
Select DO001

Select On

Select PV-Low

Select PV-HighSelect On

Select 1

4. Press the DISP/ENTER key to confirm the settings.

Setting PID Parameters in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu.

2. Press the #4 soft key (PID parameters).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft

key of each value according to the following figure.

The numerical values such as the SP are entered using the pop-up window that
appears by pressing the Input soft key.

Select 1

Set to 700.0

Select Reverse

Select 1

Keep the initial PID
values for Temp

4. Press the DISP/ENTER key to confirm the settings.

Examples of Control Setup Operation
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Control Setup Example 2: Cascade Control
Object of Control and Description

CX1000

DISP/
ENTER

1
2
3
4

High limit temperature alarm

Low limit temperature alarm

High limit steam pressure alarm

Steam

Control valve

DIGITAL OUT14

DIGITAL OUT24

DIGITAL OUT34

1 Loop 1 PV input terminal
of the control input terminal block

2 Loop 2 PV input terminal
of the control input terminal block

3 Loop 2 current output terminal
of the control input terminal block

4 Relay contact output terminal
of the control output terminal block

Pt100
Tank

Pressure
transmitter

4 to 20 mADC
current output

Primary PV input

Alarm output

LOOP1 PV1

LOOP2 PV2

Secondary
PV input

LOOP2 mA3

Primary loop of cascade control
• Loop number: 1

• PID constant: P = 20%, I = 300 s, D = 60 s
• Control direction: Reverse
• Input type: RTD Pt100

• Measurement span: 0 to 100°C
• Temperature setpoint: 80°C
• Alarm output: PV high-limit alarm (high limit: 90°C), PV low-limit alarm (low

limit: 70°C)
Secondary loop of cascade control
• Loop number: 2

• PID constant: P = 120%, I = 20 s, D = 0 s
• Control direction: Reverse
• Input type: 1-5 V

• Measurement span: 0 to 1.00 MPa
• Output type: Current output (4-20 mA)
• Alarm output: PV high-limit alarm (high limit: 0.90 MPa)

Basic Control Settings
1. Display the basic control setting menu.

See “Control Setup Example 1” for the steps to show the menu.

2. Press the #1 soft key (Control action, Input setting).

3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of the value according to the following figure, and press the DISP/ENTER key.

Examples of Control Setup Operation
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Select 1
(No need to set loop 2)

Select Cascade

Select Tem or
Press+Flow

4. Press the ESC key to return to the basic control setting menu.
5. Press the Next 1/2 soft key, and then the #5 soft key  (Output processing).

6. Press the 2 soft key.
There are no control output settings on loop 1 (primary loop of cascade control).

7. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure, and press the DISP/ENTER key.

Select 2

Select 4-20mA

Select Current-output

* No need to set
  Cycle time

8. Press the ESC key twice to return to the menu display (basic setting mode 3/4).
9. Press the Next 3/4 soft key to show the menu display (basic setting mode 4/4).

10.Press the End soft key.
A confirmation window shown below opens.

11.Press the DISP/ENTER key to confirm the settings.

Examples of Control Setup Operation
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Setting the Control Input Range in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu

shown below.

2. Press the #1 soft key (Control input range).

3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.
To set the measurement span (span lower/upper-limit), press the Input soft key and

use the numeric entry pop-up window that opens.
Setting the Input Range on the Primary Loop of Cascade Control

Select 1

Select RTD

Select PT

Set to 0.0

Set to 100.0

4. Press the DISP/ENTER key.
A confirmation window shown below opens.

5. Press the DISP/ENTER key to confirm the settings.

6. Set the input range of the secondary loop of cascade control in a similar fashion as
described in steps 3 to 5 and according to the figure below.
If you do not carry out steps 4 and 5 and change Loop number, the settings are not

saved.
Setting the Input Range on the Secondary Loop of Cascade Control

Select 2

Select 1-5V

Set to 0.00

Set to MPa
Set to 1.00

Examples of Control Setup Operation
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Setting Control Alarms in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu.

2. Press the #2 soft key (Control alarm).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft

key of each value according to the following figure.

The numeric value of the alarm is entered using the pop-up window that appears by
pressing the Input soft key.

Setting Alarms on the Primary Loop of Cascade Control

Select 1

Set to 70.0

Set to 90.0

Select DO002

Select DO001
Select On

Select PV-Low
Select PV-High

Select On Select 1

4. Press the DISP/ENTER key to confirm the settings.

5. Set the alarms of the secondary loop of cascade control in a similar fashion as
described in steps 3 and 4 and according to the figure.
If you do not carry out step 4 and change Loop number, the settings are not saved.

Setting Alarms on the Secondary Loop of Cascade Control

Select 1

Set to 0.90

Select DO003

Select On
Select PV-High

Select On

Select 2

Examples of Control Setup Operation
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Setting PID Parameters in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu.

2. Press the #4 soft key (PID parameters).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft

key of each value according to the following figure.

The numerical values such as the SP are entered using the pop-up window that
appears by pressing the Input soft key.
Setting PID Parameters on the Primary Loop of Cascade Control

Select 1

Set to 80.0

Select Reverse

Select 1

Set to P=20.0%, I=300s,
D=60s

4. Press the DISP/ENTER key to confirm the settings.

5. Set the PID parameters of the secondary loop of cascade control in a similar fashion
as described in steps 3 and 4 and according to the figure.
If you do not carry out step 4 and change Loop number, the settings are not saved.

Setting PID Parameters on the Secondary Loop of Cascade Control
Select 2

Select Reverse

Select 1

Set to P=120.0% I=20 s,
D=0 s
(No need to change the
settings if the initial PID
values are set for
Press+Flow)

Examples of Control Setup Operation
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Control Setup Example 3: Loop Control with PV Switching
Object of Control and Description

CX1000

DISP/
ENTER

1
2
3
4

Control valve

Switching valve

Steam

Distributor
+

ALM

PV1

PV2

PV switching
contact input 4 to 20mADC

current output

LOOP1 PV11

LOOP1 PV21

LOOP1 mA2

1 Loop 1 PV input terminal
of the control input terminal block

2 Loop 1 current output terminal
of the control input terminal block

3 Relay contact output terminal
of the control output terminal block

DIGITAL IN3

• Loop number: 1

• PID constant: P = 120%, I = 20 s, D = 0 s
• Control direction: Reverse
• Input type: 1-5 V for both measurement input 1 and 2

• Measurement span: PV input 1: 0 to 300 kg/h, PV input 2: 0 to 30 kg/h
• PV range conversion: Lower limit: 0 kg/h, Upper limit: 300 kg/h
• Flow rate setpoint: 100 kg/h

• Input switching condition: Contact input

Basic Control Settings
1. Show the show the basic control setting menu.

See “Control Setup Example 1” for the steps to show the menu.

2. Press the #1 soft key (Control action, Input setting).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft

key of each value according to the following figure, and press the DISP/ENTER key.

Select 1

Select PVSwitching

Select Press+Flow

Select Signal

Examples of Control Setup Operation
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4. Press the ESC key to return to the basic control setting menu.
5. Press the Next 1/2 soft key, and then the #5 soft key (Output processing).

6. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure, and press the DISP/ENTER key.

Select 1

Select 4-20mA

Select Current-output

* No need to set
  Cycle time

7. Press the ESC key twice to return to the menu display (basic setting mode 3/4).
8. Press the Next 3/4 soft key to show the menu display (basic setting mode 4/4).

9. Press the End soft key.
A confirmation window shown below opens.

10.Press the DISP/ENTER key to confirm the settings.

Setting the Control Input Range in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu

shown below.

2. Press the #1 soft key (Control input range).
3. Press the arrow keys to move the cursor (blue) to the Input type box, press the PV1

soft key, and set other parameters as shown in the figure below.
Check that 1 is selected

Select 1-5V

Select PV1

Set to 0.00

Set to 300.00

Set to kg/h

Examples of Control Setup Operation
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4. Press the DISP/ENTER key.
A confirmation window opens.

5. Press the DISP/ENTER key to confirm the settings.
6. Press the arrow keys to move the cursor (blue) to the Input type box, press the PV2

soft key, and set other parameters as shown in the figure below.
Check that 1 is selected

Select 1-5V

Select PV2

Set to 0.00

Set to 30.00

Set to kg/h

7. Press the DISP/ENTER key.
A confirmation window opens.

8. Press the DISP/ENTER key to confirm the settings.

9. Press the arrow keys to move the cursor (blue) to the Input type box, press the
PVrange soft key, and set other parameters as shown in the figure below.

Set to 0.00

Set to 300.00

Set to kg/h

Check that 1 is selected

Select PVrange

10.Press the DISP/ENTER key.
A confirmation window opens.

11.Press the DISP/ENTER key to confirm the settings.

Examples of Control Setup Operation
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Setting PID Parameters in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu.

2. Press the #4 soft key (PID parameters).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft

key of each value according to the following figure.

The numerical values such as the SP are entered using the pop-up window that
appears by pressing the Input soft key.

Select 1

Set to 100.0

Select Reverse

Select 1

Set to P=120.0%, I=20 s,
D=0 s
(No need to change the
settings if the initial PID
values are set for
Press+Flow)

4. Press the DISP/ENTER key to confirm the settings.

Control Setup Example 4: ON/OFF Control
Object of Control and Description

CX1000

DISP/
ENTER

1
2
3
4

SSR

Electric
furnace

TC LOOP1 PV1

LOOP1 NC/NO2

1 Loop 1 PV input terminal
of the control input terminal block

2 Loop 1 voltage relay contact
output terminal of the control
output terminal block

ON/OFF
control output

PV

• Loop number: 1
• Control direction: Reverse

• Relay hysteresis Setpoint: 10.0, activation position: center
• Input type: TC K type
• Measurement span: 0 to 1200°C

• Output type: ON/OFF control output
• Temperature setpoint: 700°C

Basic Control Settings
1. Show the basic control setting menu.

See “Control Setup Example 1” for the steps to show the menu.

Examples of Control Setup Operation
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2. Press the #1 soft key (Control action, Input setting).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft

key of each value according to the following figure, and press the DISP/ENTER key.

Select 1

Select Single

Select Temp

4. Press the ESC key to return to the basic control setting menu.
5. Press the #3 soft key (Output processing).
6. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft

key of each value according to the following figure, and press the DISP/ENTER key.

Select 1

Select On/Off-control

* No need to set
  Cycle time and
  Analog-output type

7. Press the DISP/ENTER key to confirm the settings.
8. Press the ESC key twice to return to the menu display (basic setting mode 3/4).

9. Press the Next 3/4 soft key to show the menu display (basic setting mode 4/4).
10.Press the End soft key.

A confirmation window opens.

11.Press the DISP/ENTER key to confirm the settings.

Examples of Control Setup Operation
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Setting the Control Input Range in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu

shown below.

2. Press the #1 soft key (Control input range).

3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.
The numeric values of the lower/upper limit of range are entered using the pop-up

window that appears by pressing the Input soft key.
Select 1

Select TC

Select K

Select PV1

Set to 0.0
Set to 1200.0

4. Press the DISP/ENTER key.

A confirmation window shown below opens.
5. Press the DISP/ENTER key to confirm the settings.

Setting Control Parameters in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu.
2. Press the #4 soft key (PID parameters).

3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.
The numeric values of the target setpoint and relay hysteresis setpoint are entered

using the pop-up window that appears by pressing the Input soft key.
Select 1

Set to 700.0

Select Reverse

Select 1

Set to 10.0
Select Mid

4. Press the DISP/ENTER key to confirm the settings.

Examples of Control Setup Operation
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Setting the Display Items on the Control Group Display (Control Group Setting)
Below are the procedures for displaying loops 1 and 2 and measurement channel (input

channel for measurement) 1 and 2 on the control group display (group name: CONTROL
GROUP 1) of group number 1.

1. From the operation display, click the MENU key and then the Next 1/2 soft key to

display the control setting menu 2/2 shown below.
Menu (Setting mode (Control) 1/2) Menu (Setting mode (Control) 2/2)

2. Press the #5 soft key to show the Control group setting display.

3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.

Select On

Select Int-Loop or Meas CH
If internal loop, select the loop number.
If measurement channel, select the channel number.

4. Press the DISP/ENTER key to confirm the entry.

Control Group Display Example after Setup

Measured value
of measurement
channel 1 and 2

Control status
display of
internal loops
1 and 2

Examples of Control Setup Operation
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Displaying the Trend of PV, SP, and OUT Values
Below are the procedures for displaying the trends of PV, SP, and OUT of loop 1 and the

values of measurement channels 1 and 2 on the trend display of group number 1 (group
name: GROUP 1).
1. From the operation display, open the Group set, Trip line setting display according to

the following procedure.
Press the MENU key (to switch to Setting mode (Control)) and then the MENU key
(switch to Set mode).  Press the #4 soft key (to select Display) and then the #1 soft
key (to select Group set, Trip line).

Menu (Setting mode (Control))

Menu (Display)

Menu (Set mode 1/2)

Menu (Set mode 2/2)

2. Press the arrow keys to move the cursor (blue) to the Channel setting box.

3. Press the Input soft key to open the channel input pop-up window.

4. Use the arrow keys and the DISP/ENTER key to select the channels to include in
the group.
In this group setting, the PV, SP, and OUT of loop 1 are assigned channel numbers

101, 102, and 103, respectively.  To include PV, SP, and OUT of loop 1, enter 101-
103 or 101.102.103.  For measurement channels 1 and 2, enter 01.02.
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Enter 101-103.01.02

Channel input
pop-up window

5. Select the ENT key on the channel input pop-up window and press the DISP/ENTER
key.

6. Press the DISP/ENTER key to confirm the entry.

Note
You can select up to 10 channels from measurement channels (CH1 to CH06), computation

channels (CH31 to CH42), internal control channels (CH101 to CH106), and external control

channels (CH201 to CH212) using Channel setting.

• Assignment of internal control channels (channels of internal loops)

The data of two loops is assigned to channel numbers as follows:

Loop 1 PV: 101, Loop 1 SP: 102, Loop 1 OUT: 103

Loop 2 PV: 104, Loop 2 SP: 105, Loop 2 OUT: 106

• Assignment of external control channels (channels of external loops)

The data of four loops is assigned to channel numbers as follows:

External loop 1 PV: 201, External loop 1 SP: 202, External loop 1 OUT: 203

External loop 2 PV: 204, External loop 2 SP: 205, External loop 2 OUT: 206

External loop 3 PV: 207, External loop 3 SP: 208, External loop 3 OUT: 209

External loop 4 PV: 210, External loop 4 SP: 211, External loop 4 OUT: 212

Set the channels to assign them to a group according to the following rules.

• Enter the channel number using two or three digits.

• Separate each channel with a period.

• Use a hyphen to specify consecutive channels.

Trend Display Example after Setup

Displaying the Trend of PV, SP, and OUT Values
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Switching the Operation Mode
For details on the procedure for switching the operation mode, see chapter 6,

“Operations during Control Operation” in the CX1000 User’s Manual (IM 04L31A01-03E).
The following is a procedural example on the control group display.

Run/Stop Operation
For cascade control, the following operations can be performed only when the secondary
loop is selected.
1. Use the arrow keys to move the cursor to the desired control loop.

Cursor (   )

2. Press the RUN/STP soft key.
A pop-up window for running and stopping the operation appears.

Window for starting and
stopping operation

3. Select RUN or STOP using the up and down arrow keys.
4. Press the DISP/ENTER key to confirm the changes.

Switching between Auto, Manual, and Cascade Control
You can only switch to the cascade mode on the secondary loop of cascade control.

1. Use the arrow keys to move the cursor to the desired control loop.
2. Press the Mode soft key.

The MODE selection pop-up window appears.

MODE selection window

3. Select AUT (auto), MAN (manual), or CAS (cascade) using the up and down arrow
keys.

4. Press the DISP/ENTER key to confirm the changes.
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Changing the Target Setpoint
1. Use the arrow keys to move the cursor to the desired control loop.

2. Press the SP soft key.
The SP modification pop-up window appears.  The window shows the current target
setpoint.

Window for changing the
target setpoint

3. Change the target setpoint using the up and down arrow keys.
4. Press the DISP/ENTER key to confirm the changes.

Changing the Control Output
The following operation cannot be performed during auto operation, when operation is
stopped, or when the primary loop of cascade control is selected.  When the operation is

stopped, the preset value is output.
1. Use the arrow keys to move the cursor to the desired control loop.
2. Press the OUT soft key.

The OUT modification pop-up window appears.  The window shows the current
control output.

Window for changing the
control output

3. Change the control output using the up and down arrow keys.
The control output is set to the new value at this point.

4. Press the DISP/ENTER key to complete the procedure.

Switching the Operation Mode
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Switching between Remote and Local Modes
The soft key menu does not show REM/LOC, if Control > Contact input-registration/

AUX(Alarm mode... > Remote setting is set to Off.  Remote input cannot be used for the
target setpoint when the secondary loop of cascade control is selected or during program
control.  Thus, there is no remote/local switching in these cases.

1. Use the arrow keys to move the cursor to the desired control loop.
2. Press the REM/LOC soft key.

A pop-up window for switching between remote and local appears.

Window for switching between
remote and local

3. Select REMOTE or LOCAL using the up and down arrow keys.
4. Press the DISP/ENTER key to confirm the changes.

Switching between Automatic and Manual for the Analog Retransmission Loop
You can switch the output mode for the control loop specified for analog retransmission.

When set to AUTO, the computed result of analog retransmission is output.  When set to
MAN, you can set the direct output value.
1. Use the arrow keys to move the cursor to the desired control loop.

2. Press the [MODE] soft key.
A pop-up window switching between auto and manual appears.

Auto/manual switching window

3. Select AUTO or MAN using the up and down arrow keys.
4. Press the DISP/ENTER key to confirm the changes.

Switching the Operation Mode
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Changing the Analog Retransmission Output
MAN must be set for the MODE using the procedure above.

1. Use the arrow keys to move the cursor to the desired control loop
2. Press the [OUT] soft key.  The Output Value Setting window appears.

3. Change the output value using the up and down arrow keys.  The currently set
control output value is displayed in the window.

Switching between Automatic and Manual for the DIO Operation Monitoring
You can switch the output mode for the DO specified in the DIO Operation Monitoring

Function.  When set to AUTO, the internal switch status is output.  When set to MAN,
you can switch the direct output value between 0 and 1.

1. Use the arrow keys to move the cursor to the desired control loop.

2. Press the [MODE] soft key.
A pop-up window switching between auto and manual appears.

Auto/manual switching window

3. Select AUTO or MAN using the up and down arrow keys.
4. Press the DISP/ENTER key to confirm the changes.

Switching the Operation Mode
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Tuning Operation
For details on the procedure of switching the operation mode, see chapter 6, “Operations

during Control Operation” in the CX1000 User’s Manual (IM 04L31A01-03E).
Displaying the Tuning Display

Press the TUNING soft key on the control group display.

→

Auto Tuning
To execute auto tuning, Basic setting mode > #10 Control > #1 Control action, Input
setting > Auto tuning must be turned On before carrying out the following procedure.
1. Press the AUTO TUN soft key on the tuning display.

As shown in the following figure, the auto tuning setup pop-up window appears along
with a warning message.

Auto tuning setup window
2. Select the control loop using the up and down arrow keys.

3. Press the DISP/ENTER key to execute auto tuning.

CAUTION
• You cannot execute auto tuning during ON/OFF control.
• Do not execute auto tuning when controlling the following types of processes.  If

you do, malfunction may occur in the control process.
• Control process with fast response such as flow control and pressure control.
• Processes that result in adverse consequences when the output is turned on/off

even if temporarily.
• Processes that result in adverse consequences if a large output change is

applied to the control element.

• Processes that may cause adverse effects on the quality of a product when the
process value exceeds the allowed fluctuation width.
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Manual Tuning
1. Press the arrow keys on the tuning display.

A cursor appears in the control parameter display section.
2. Select the control parameter you wish to change using the arrow keys.
3. Press the DISP/ENTER key.

The parameter modification pop-up window appears.
Cursor

Control parameter
dislay section

Window for changing parameters

4. Change the value using the up and down arrow keys.
5. Press the DISP/ENTER key to confirm the changes.

To close the window without making any changes, press the ESC key.

Tuning Operation
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Program Control Function (/PG1 and /PG2 Options)
Program Control Function Introduction

Program control function is used to ramp-up or ramp-down the SP according to a
program pattern.  The number of program patterns that you can create with the CX1000
is as follows:

• /PG1 option: 4
• /PG2 option: 30
Up to 99 segments can be specified in a single pattern.

/PG1: 4 patterns
/PG2: 30 patterns

Segment
Time

S
P

Operation Mode during Program Control
The following 4 types of operation modes are available.

Reset mode Local operation mode

Program control mode Hold operation mode

Switch 
the loop 

to program control.

Switch the loop to local.
End program to local.

The program control of all loops is stopped.  
All event outputs are cleared (off).

When switched to local operation mode 
even during program control, 

fixed-point operation is carried out 
according to the SPs specified locally.

The raising or lowering of the SP 
according to the program pattern 

during program control 
is forcibly held such as through key operation.

Control operation is being carried out 
according to the program pattern.

Program in operation

Clear hold.

Start 
program control.

Execute hold.

Reset.
Stop all loops.

Start loop 
operation.

Reset.
End program to reset. 
Stop all loops.

Start 
program control

Operations on the Program Selection Display (See the figure on the next page)
Displaying the Program Selection Display

On the control group display or control overview display, select CONTROL >

PROGRAM from the screen selection menu.

Starting Program Control
Program control starts, and the screen switches to the Program Control Display.

1. On the Program Selection Display, press the RUN soft key.
A pop-up window for starting the program control appears.

Window for starting 
the program control

2. Press the DISP/ENTER key.
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Program Selection Display Example

Segment range to be repeated

Repeat frequency

Preset pattern waveform

Soft key menu 3/4

Display the program pattern 
control start delay time

Start segment number display

* The selected segment is the 
 segment displayed at the

left end. Select the segment
using the left and right
arrow keys.

Target SP display of the 
selected segment*

Program pattern name

Selected pattern number

Selected segment* number

Selected segment* time

Soft key menu 2/4

The selected segment

Show the program control display
(valid only during program control)

Switch full display/split display

Shift the displayed segment by +10 segments
Shift the displayed segment by –10 segments

Switch the program pattern
Display the window for starting the program control

Switch tag/tag comment display

Display the window for setting the program pattern control start delay time
Display the window for setting the program pattern
start segment

Display the ON/OFF selection menu of program 
pattern display loops

Switches to control group display (style number S3 or later)
Switches to overview display (style number S3 or later)

Display the window for the selection menu for the event display method
 (style number S3 or later)

Turns the event display ON/OFF (style number S3 or later)

Soft key menu 3/4

Settings for pattern to be run as a result of communication function, 
DI/DO, or internal switch action

Soft key menu 4/4

Operations on the Program Control Display (See the figure on the next page)
Displaying the Program Control Display

When you start the program control on the program selection display, the program

control display appears.  You can display the program control display when program
control is in progress by selecting CONTROL > PROGRAM from the display
selection menu on the control group display or the control overview display or

pressing the RUN PNL soft key on the program selection display.

Executing and Clearing the Hold Operation
You can hold the progress of the program (stop the timer).  While in hold, you can
change the segment SP or increase or decrease the remaining segment time.

1. Press the HOLD soft key.

A pop-up window for executing/clearing the hold operation appears.
Window for executing/
clearing the hold operation.

2. Select ON (execute) or OFF (clear) using the up and down arrow keys.
3. Press the DISP/ENTER key.

Program Control Function (/PG1 and /PG2 Options)
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Resetting Program Control
Resets the program control and stops.

1. Press the RUN/RST soft key.
A pop-up window for starting and resetting program control appears.

Window for starting and 
resetting program control

2. Select RESET using the up and down arrow keys.
3. Press the DISP/ENTER key.

Program Control Display Example

Remaining time display of 
the control segment

Tag/Tag comment display

PV, SP, and OUT display

Cursor indicating the program execution position

Repeat segment range

Repeat frequency and 
repeat count values

Displays wait time when in 
wait mode

Program pattern name

Control pattern number display

Control mode

Preset pattern waveform
(SP, dotted line)

PV waveform (solid line)*

* PV waveforms are displayed 
 when youpress the START
 key to start the data
 acquisition to the internal 
 memory.

HOLD (blinking): Hold mode
WAIT:  Wait mode
DELAY:  Program pattern

controlled being
delayed

Control segment number

Soft key menu when in hold mode

Soft key menu  2/3

Switch tag/tag comment display

Show the program selection display

Switch full display/split display

Hold the program

Display the window for starting program control and resetting
Advance the program

Display the ON/OFF selection menu of program pattern display
loops

Display the menu for selecting the loop of which
the target SP is to be changed

Display the window for changing the remaining segment time

Switch to control group display (style number S3 or later)
Switch to overview display (style number S3 or later)

Display the selection menu for the event display method
(style number S3 or later)

Turn the event display ON/OFF(style number S3 or later)

Soft key menu  3/3

Switching between Program Control and Local Control for Each Loop
Press the PRG/LOC soft key on the control group screen to switch between program

and local.

Program Control Function (/PG1 and /PG2 Options)
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Executing Several Program Patterns
You can execute multiple program patterns whose loop numbers do not overlap.

Switching Pattern Numbers
1. Press the [PT NO.] soft key in the program selection screen.

The pattern number switching pop-up window appears.  The currently set pattern

numbers are displayed in the window.
2. Select a pattern number using the up and down arrow keys.
3. Press DISP/ENTER key to confirm the changed settings.

To close without saving, press the ESC key.

Program Operation Start
1. Press the [RUN] soft key.

The program operation start pop-up window appears.
2. Press the DISP/ENTER key.  The screen changes to the program operation display.

Displaying the Program Selection Display
1. Press the [SEL PNL] soft key.

The screen changes to the program selection display.

Executing a Separate Program Pattern
1. Repeat the above procedure as necessary.

Switching the Displayed Pattern in the Program Operation Display
1. Press the left or right arrow keys to switch the displayed pattern.

Program Control Setup Operation
Program Control Setup Operation Sequence

First, set the control functions of the loops to be used (see below).  Next, set the

program control (see page 37).

Setting the Control Operation of the Loops to Be Used
This section explains only the settings specific to the program control.

• Control > [Control action, Input setting] setup screen
For a description of the setup procedure, see pages 11 and 12.

Select the operation status when a power 
failure occurs during program control and 
the power recovers.
• [Continue]: Continues program control.
• [Manual]: Switches the loop to manual 
  operation.
• [Reset]: Resets program control. 

Select [On].

Program Control Function (/PG1 and /PG2 Options)
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Program Control Related Setup Operations
Follow the flow chart below.

For further details on each function, see  section 1.11, “Program Control Related
Settings” in the CX1000 User’s Manual (IM 04L31A01-03E) provided on the
accompanying CD-ROM.

#1

END

END

DISP/ENTER key

#1

DISP/ENTER key

ESC key*2

#7

ESC key

Select pattern number and 
then change the settings.

ESC key

DISP/ENTER 
key

#2 to #8 ESC key

Change the settings on setting screens 
#2 to #8.

[#7 Program-control parameters] appears 
only if you set [Program control] to [On] 
under [Control action, Input setting] on 
page 36.

#1 Pattern initial setting

MENU key (switch to the Setting mode (Control))
 > Next 1/2 soft key

#1*1

1

2

3

4

5 6

7

8

*1 If you set pattern parameters of other numbers 
 after this step, all settings up to that point are 
 cleared.
*2 If you did not change the settings on the Pattern 
 initial setting screen

ESC key*2

To set a single pattern, carry out steps 1 to 8.

Setup Sequence
First, enter pattern initial settings (1 to 4 above).

Next, set [#2 Wait action setting] through [#8 Repeat action setting] (5 and 6 above).
Return to the Program-control parameters screen (7 and 8 above).
Set [#2 Aux (Auto message, Display position).] and [#3 Aux (Event group).]

Refer to the figure above for the following procedures.

Program Control Function (/PG1 and /PG2 Options)
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Pattern Initial Setting

Enter the program pattern number.
/PG1: 1 to 4, /PG2: 1 to 30

Select the time or ramp-rate (see below).

Enter the pattern name (up to 16 characters).

Enter the number of segments to be used.
1 to 99

Specify the position of the segment to be 
deleted or added.

Rate-of-change

Target SP

Segment time Minute or hour

Method for creating the segment 
using the target SP and the 
ramp-rate of the SP change.  
Set the ramp-rate using rate-of-
change per minute (example: 
2°C per minute) or rate-of-change 
per hour (example: 10°C per hour).

Method for creating the 
segment using the target 
SP and the segment time.

Segment setting method: Time Segment setting method: Ramp-rate

Target SP

Wait Action Setting
Set 5 types of wait actions.  Specify the wait action for each segment.

Select [On] to set a wait zone.

Wait zone number

Enter the maximum wait time when using the 
wait function at the time of segment switching 
(see below).

Set the wait zone (engineering unit).
Wait zone H (high)

Wait zone L (low)
SP

Wait function at the time of segment switching

If the PV is outside the wait zone when the SP reaches the target SP 
of the segment, the program does not advance to the next segment.  
When the PV enters the wait zone, the program advances to the next 
segment.  In addition, when the wait time elapses even if the PV does
not enter the wait zone, the program advances to the next segment.  
If the wait zone is set to 00:00:00, the program does not advance to 
the next segment until the PV reaches the wait zone.

Segment 1 Segment 2

Wait zone high

Wait zone low

Wait zone high

Wait zone low

Wait time 
(specified value)

Actual wait time

PV

SP

Wait function within the segment

The advancing of the program control stops when the SP exits from 
the wait zone.  When the PV returns within the wait zone, the 
advancing of the program control resumes.  [Segment time] setting 
is irrelevant for wait within the segment.  The advancing of the 
program control is stopped until the PV reaches the wait zone.

Wait time

PV

SP

Target SP

Program Control Function (/PG1 and /PG2 Options)
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Pattern Start Setting

Enter the SP of the pattern start point.

Select the operation when starting the program 
control (see below).

Select the operation start condition (Start code) from the following.

Starting 
target SP

Start code: StartTargetSP

Start code: RampPV1Start to RampPV6Start

Start code: TimePVStart

Segment time (specified value)

PV at the start 
of control

Starts from this SP.

Ramp-rate of the SP change 
(specified value)

Segment time (specified value)

Actual segment time

PV at the start 
of control Starts from this SP.

Segment time (specified value)

Segment time (specified value)

Time-prioritized PV start
The program control starts from the SP corresponding 
to the PV of each loop.  The segment time is maintained 
as specified.  The ramp-rate of the SP change varies 
depending on the position of the PV.

Starting SP Start
Program starts from the starting target SP.

Ramp-prioritized PV1 to PV6 start
The program control starts from the SP corresponding 
to the PV (PV1 to PV6) of the specified loop.  For other 
loops, the program control starts from the same point 
as the start point of the specified loop.  The ramp-rate 
of the SP change is maintained as specified.  The 
segment time is shortened.

Target SP

Target SP

Target SP

Program Control Function (/PG1 and /PG2 Options)



42 IM 04L31A01-04E

Program Pattern Setting
• When the segment setting method is set to [Time]

Select the segment number.

Select the wait zone number to be applied.

Select the PID number to be used
(Not displayed when zone PID is selected).

Select the operation when ending the segment. 
• [Continue]: Advance to the next segment.
• [Hold]: Hold the program progress.
• [Local]: End by setting the loop to local mode.
• [Reset]: End by stopping the loop.

Select the wait action type (see page 38).

Enter the target SP of the segment.

Select ramp or soak.

Enter the segment time.

Ramp Soak

• When the segment setting method is set to [Ramp]

Select the ramp time unit.
• [Hour]: 1 hour
• [Minute]: 1 minute

Enter the rate-of-change per unit time using 
engineering unit.

Same as the figure above.

Same as the figure above.

Event Setting
• When the event kind is set to [TimeEvent]

Select the segment number to which the event 
is to be assigned.

Select the type of time event ([On/Off], [On/**], 
or [**/Off]) (see below).

Select [TimeEvent] (see below).

Select the event number range, [1-8] or [9-16].

Set the time for turning ON/OFF the contact 
output in terms of the time elapsed from the 
start point of the segment (see below).

Time event is a function used to turn ON or OFF the contact output after a specified
time elapses by starting the clock from the time the segment operation is started.

On- time
Off-time

On-time

Segment n n+1 Segment n n+1 Segment n n+1

Off-time

Event output

Type of time event [On/Off] [On/**] [**/Off]

Up to 16 time events can be specified for each segment.  There are 3 types of time events.

TimeEvent

Program Control Function (/PG1 and /PG2 Options)
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• When the event kind is set to [PVEvent]

Select the segment number to which the event 
is to be assigned.

Select [PVEvent] (see below).

Select the loop to which the event is to be 
assigned.

Enter a value when the PV event is to be 
detected using engineering unit.

Select the type of PVEvent (see below).

Select the event number range, [1-8] or [9-16].

This function outputs preset alarms such as PV alarms, SP alarms, and output

alarms during program operation.  Up to 16 PV events can be specified for each
segment.  PV events operate only within the specified segment.

PV event

Event output

PV high-limit alarm (PV-H) example

Set value

PV

SP

Select the type of PV events from the following.
• PV-H (PV high-limit), PV- L (PV low-limit), 
 Dev-H (deviation high-limit), Dev-L (deviation low-limit), 
 Dev-H&L (deviation high & low limit), 
 and D-W-H&L (deviation within high & low limits)
• SP-H (SP high-limit) and SP-L (SP low-limit)
• Out-H (output high-limit) and Out-L (output low-limit)

Event Output Destination Setting
The even output destination is set using the Event output setting display (see
[Program-control parameters] display on page 37).

Repeat Action Setting

Select [On] or [Repeat] when using the repeat 
action.
• [On]: Repeats the specified number of 
  times
• [Repeat]: Repeats infinitely

Enter the number of repetitions when [Repeat 
action] is set to [On].

Set the range of segments to be repeated.

Execute segment 3 to 5 
twice (repeat frequency: 2)

Repeat action

Pattern created

1
2

3
4

5
6

7 1
2

3
4

5
6

7

3
4

5

Pattern executed

Executed twice

Program Control Function (/PG1 and /PG2 Options)
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List of Parameters
Below is a list of parameters for the model with the various function options.  However,

settings related to the program control function option are not given.
Basic Setting Mode
#1 Alarm

Parameter Selectable Range or Selections Initial Value

Alarm > Reflash On/Off Off
Alarm > Relay > AND None, I01, I01-I02, I01-I03, ... , or I01-I06 None
Alarm > Action Energize or Deenergize Energize
Alarm > Behavior Hold or Nonhold Nonhold
Alarm > Indicator Hold or Nonhold Nonhold
Alarm > Rate of change > Increase/Decrease 1 to 15 1
Alarm > Hysteresis On/Off On

#2 A/D, Temperature

Parameter Selectable Range or Selections Initial Value

A/D Integrate > Integrate Auto, 50 Hz, 60 Hz, or 100 ms Auto
A/D > Scan interval 1 s or 2 s 1 s
A/D > First-CH 01 to 06 01
A/D > Last-CH 01 to 60 01
A/D > Burnout set Off, Up, or Down Off
A/D > RJC Internal or External Internal
A/D > Volt (uV) –20000 µV to 20000 µV 0 µV
Temperature > Unit C or F C

#3 Memory

Parameter Selectable Range or Selections Initial Value

Memory > Save Manual or Auto Auto
Memory > Data Display, E+D, or Event Display
Memory > Event > Sample rate 1 s, 2 s, 5 s, 10 s, 30 s, 60 s, 120 s, 300 s, or 600 s 1 s
Memory > Event > Mode Free, Trigger, or Repeat Trigger
Memory > Event > Block 1, 2, 4, 8, or 16 1
Memory > Event > Data length 3 minutes to 31 days 1 h
Memory > Event > Pre-trigger 0, 5, 25, 50, 75, 95, or 100 0
Memory > Event > Trigger > Key On/Off On
Memory > Event > Trigger > External On/Off Off
Memory > Event > Trigger > Alarm On/Off Off

#4 Memory and Trend, Memory Timeup

Parameter Selectable Range or Selections Initial Value

Memory and trend > Meas/Math/Loop CH Meas CH, Math CH, Int CH, or Ext CH Meas CH
Memory and trend > First-CH Meas CH: 01 to 06, Math CH: 31 to 42, 01

Int CH : 101 to 106, or Ext CH: 201 to 212
Memory and trend > Last-CH Meas CH: 01 to 06, Math CH: 31 to 42, 01

Int CH : 101 to 106, or Ext CH: 201 to 212
Memory and trend > On/Off On/Off On
Memory timeup > Timeup type Off, Hour, Day, Week, or Month Off
Memory timeup > Date 1 to 28 1
Memory timeup > Time (hour) 0 to 23 0

#5 Keylock

Parameter Selectable Range or Selections Initial Value

Keylock > Use/Not Use/Not Not
Keylock > Password Up to 6 alphanumeric characters –
Keylock > Keys such as START Free or Lock Free
Key lock > Soft keys such as ALARM ACK Free or Lock Free
Key lock > Control settings such as the input range Free or Lock Free
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#6 Key login

Parameter Selectable Range or Selections Initial Value

Key login > Use/Not Use/Not Not
Key login > Auto logout On/Off Off
Key login > UserID Use/Not Use/Not Not
Key login > Number 1, 2, 3, 4, 5, 6, or 7 1
Key login > On/Off On/Off On
Key login > User name Up to 16 alphanumeric characters user1
Key login > User ID Up to 4 alphanumeric characters 1
Key login > Password Up to 6 alphanumeric characters –
Key login > setup On or Off On

#7 Load, Initialize...

Parameter Selectable Range or Selections Initial Value

Load, Initialize > #1 Load settings – –
Load, Initialize > #2 Delete – –
Load, Initialize > #3 Format – –
Load, Initialize > #4 Initialize > Kind Clear1 to Clear3 Clear3

#8 Option
<#1 Remote>

Parameter Selectable Range or Selections Initial Value

Remote > Action No. 1 to No. 8 None, MemoryStartStop, Trigger, AlarmACK, None
TimeAdjust, MathStartStop, MathReset,
Manual sample, Panel1Load, Panel2Load,
Panel3Load, Message1, Message2,
Message3, Message4, Message5,
Message6, Message7, Message8,
Snapshot

<#2 Report>

Parameter Selectable Range or Selections Initial Value

Report > Report set Off, Hour, Day, Hour+Day, Day+Week, or Day+Month Off
Report > Date1 1 to 28 1
Report > Day of the week2 SUN, MON, TUE, WED, THU, FRI, or SAT SUN
Report > Time(hour) 0 to 23 0
Report > Report CH R01 to R12 R01
Report > Off/On On/Off On
Report > Channel 01 to 06, 31 to 42 01
Report > Sum scale Off, /s, /min, /h, or /day /s
1 When the report type is monthly report
2 When the report type is weekly report

<#3 Timer (TLOG)>

Parameter Selectable Range or Selections Initial Value

Timer(TLOG) > No. 1 to 3 1
Timer(TLOG) > Mode Off, Relative, or Absolute Absolute

2 and 3: Off
Timer(TLOG) > Interval 1 min, 2 min, 3 min, 4 min, 5 min, 6 min, 10 min, 12 min, 1 h

15 min, 20 min, 30 min, 1 h, 2 h, 3 h, 4 h, 6 h, 8 h, 12 h,
or 24 h

Timer(TLOG) > Ref.time 0:00 to 23:00 0:00
Timer(TLOG) > Reset On/Off Off
Timer(TLOG) > Action Off or DataSave Off

List of Parameters
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#9 Communication
<#1 Ethernet (IP_Address)>

Parameter Selectable Range or Selections Initial Value

Ethernet (IP_Address) > IP-address – 0.0.0.0
Ethernet (IP_Address) > Subnet mask – 0.0.0.0
Ethernet (IP_Address) > Default gateway – 0.0.0.0

<#2 Ethernet (DNS)>

Parameter Selectable Range or Selections Initial Value

Ethernet (DNS) > DNS On/Off On/Off Off
Ethernet (DNS) > Server search order > Primary – 0.0.0.0
Ethernet (DNS) > Server search order > Secondary – 0.0.0.0
Ethernet (DNS) > Host name Up to 64 alphanumeric characters –
Ethernet (DNS) > Domain name Up to 64 alphanumeric characters –
Ethernet (DNS) > Domain suffix search order > Primary Up to 64 alphanumeric characters –
Ethernet (DNS) > Domain suffix search order > Secondary Up to 64 alphanumeric characters –

<#3 FTP transfer file>

Parameter Selectable Range or Selections Initial Value

FTP transfer file > Disp&Event data On/Off Off
FTP transfer file > Report On/Off Off

<#4 FTP connection>

Parameter Selectable Range or Selections Initial Value

FTP connection Primary or Secondary Primary
FTP connection > FTP server name Up to 64 alphanumeric characters –
FTP connection > Port number 1 to 65535 21
FTP connection > Login name Up to 32 alphanumeric characters –
FTP connection > Password Up to 32 alphanumeric characters –
FTP connection > Account Up to 32 alphanumeric characters –
FTP connection > PASV mode On/Off Off
FTP connection > Initial path Up to 64 alphanumeric characters –

<#5 Control (Login, Timeout)>

Parameter Selectable Range or Selections Initial Value

Ethernet login > Use/Not Use/Not Not
Ethernet login > Level admin, user1, user2, user3, user4, user5, admin

or user6
Ethernet login > Level > On/Off On/Off On
Ethernet login > Level > User name Up to 16 alphanumeric characters admin
Ethernet login > Level > Password Up to 6 alphanumeric characters 0
Application time out > On/Off On/Off Off
Application time out > Time 1 to 120 1 min
Keep alive > On/Off On/Off On

<#6 Serial, Memory out>

Parameter Selectable Range or Selections Initial Value

Serial > Baud rate 1200, 2400, 4800, 9600, 19200, or 38400 bps 9600 bps
Serial > Data length 7 or 8 8 bit
Serial > Parity Odd, Even, and None Even
Serial > RS-232 > Handshaking Off:Off, XON:XON, XON:RS, or CS:RS Off:Off
Serial > RS-422/485 > Address 1 to 32 1
Serial > RS-422/485 > Protocol Normal, Modbus, Modbus-M, or Ladder Normal
Memory output Ethernet or serial Ethernet

List of Parameters
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<#7 Modbus master (BASIC)>

Parameter Selectable Range or Selections Initial Value

Basic settings > Read cycle 125 ms, 250 ms, 500 ms, 1 s, 2 s, 5 s, 10 s, 15 s, 2 s
20 s, or 30 s

Basic settings > Timeout 125 ms, 250 ms, 500 ms, 1 s, 2 s, 5 s, 10 s, or 1 min 2 s
Basic settings > Retrials Off, 1, 2, 3, 4, 5, 10, or 20 1

<#8 Modbus master (COMMAND)>

Parameter Selectable Range or Selections Initial Value

Command settings > 1 to 8 On/Off Off
Command settings > 1 to 8 > First-CH, Last-CH C01 to C30 C01, C01
Command settings > 1 to 8 > Address 1 to 247 1
Command settings > 1 to 8 > Slave Registers Input registers: 30001 to 39999, 300001 to 365535 30001

Hold registers: 40001 to 49999, 400001 to 465535
Command settings > 1 to 8 > Type INT16, UINT16, INT32_B, INT32_L, UINT32_B, INT16

UINT32_L, FLOAT_B, or FLOAT_L

<#9 AUX>

Parameter Selectable Range or Selections Initial Value

Recovery Status for Comm. Buffer > DO/SW Continue, Clear Clear
Modbus master/Ext loop > Auto recovery On/Off Off

#10 Web, E-Mail
<#1 Web>

Parameter Selectable Range or Selections Initial Value

Web > Use/Not Use/Not Not
Web > Page type Operator or Monitor Operator
Web > On/Off On/Off Off
Web > Command On/Off Off
Web > Access control On/Off Off
Web > User name Up to 16 alphanumeric characters –
Web > Password Up to 6 alphanumeric characters –

<#2 Basic E-Mail Settings>

Parameter Selectable Range or Selections Initial Value

Basic E-Mail settings > SMTP server name Up to 64 alphanumeric characters –
Basic E-Mail settings > Port number 0 to 65535 25
Basic E-Mail settings > Recipient 1 Up to 150 alphanumeric characters –
Basic E-Mail settings > Recipient 2 Up to 150 alphanumeric characters –
Basic E-Mail settings > Sender E-mail address assigned by the network

administrator (up to 64 alphanumeric characters) –

<#3 Alarm E-Mail Settings>

Parameter Selectable Range or Selections Initial Value

Alarm E-Mail settings > Recipient1 On/Off Off
Alarm E-Mail settings > Recipient2 On/Off Off
Alarm E-Mail settings > Alarm1 to 4 On/Off Off
Alarm E-Mail settings > Include INST On/Off Off
Alarm E-Mail settings > Include source URL On/Off Off
Alarm E-Mail settings > Subject Up to 32 alphanumeric characters (CX) Alarm_summary
Alarm E-Mail settings > Header1 Up to 64 alphanumeric characters –
Alarm E-Mail settings > Header2 Up to 64 alphanumeric characters –

List of Parameters
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<#4 Scheduled E-Mail Settings>

Parameter Selectable Range or Selections Initial Value

Scheduled E-Mail settings > Recipient1 On/Off Off
Scheduled E-Mail settings > Interval 1 h, 2 h, 3 h, 4 h, 6 h, 8 h, 12 h, or 24 h 24 h
Scheduled E-Mail settings > Ref.time 00:00 to 23:59 00:00
Scheduled E-Mail settings > Recipient2 On/Off Off
Scheduled E-Mail settings > Interval 1 h, 2 h, 3 h, 4 h, 6 h, 8 h, 12 h, or 24 h 24 h
Scheduled E-Mail settings > Ref.time 00:00 to 23:59 00:00
Scheduled E-Mail settings > Include INST On/Off Off
Scheduled E-Mail settings > Include source URL On/Off Off
Scheduled E-Mail settings > Subject Up to 32 alphanumeric characters (CX) Periodic_data
Scheduled E-Mail settings > Header1 Up to 64 alphanumeric characters –
Scheduled E-Mail settings > Header2 Up to 64 alphanumeric characters –

<#5 System E-Mail Settings>

Parameter Selectable Range or Selections Initial Value

System E-Mail settings > Recipient1 On/Off Off
System E-Mail settings > Recipient2 On/Off Off
System E-Mail settings > Include source URL On/Off Off
System E-Mail settings > Subject Up to 32 alphanumeric characters (CX) System_warning
System E-Mail settings > Header1 Up to 64 alphanumeric characters –
System E-Mail settings > Header2 Up to 64 alphanumeric characters –

<#6 Report E-Mail Settings>

Parameter Selectable Range or Selections Initial Value

Report E-Mail settings > Recipient1 On/Off Off
Report E-Mail settings > Recipient2 On/Off Off
Report E-Mail settings > Include source URL On/Off Off
Report E-Mail settings > Subject Up to 32 alphanumeric characters (CX) Report_data
Report E-Mail settings > Header1 Up to 64 alphanumeric characters –
Report E-Mail settings > Header2 Up to 64 alphanumeric characters –

#11 Aux, Time zone

Parameter Selectable Range or Selections Initial Value

AUX > Tag/Channel Tag/Channel Tag
AUX > Memory alarm Off, 1 h, 2 h, 5 h, 10 h, 20 h, 50 h, or 100 h 1 h
AUX > Language English, Japanese, German, or French English
AUX > Partial Use/Not Not
Time zone > Difference from GMT –1200 to 1200 0

#12 Control
<#1 Control action>

Parameter Selectable Range or Selections Initial Value

Control action > PID number 1 to 8 8
Control action > Control period 250 ms, 500 ms, or 1 s* 250 ms
Control action > Zone PID On/Off Off
Control action > Restart mode > Fixed-Point Continue, Manual, or Auto Continue
Control action > Restart mode > Program Continue, Manual, or Reset Continue
Control action > Initial PID Temp or Press+Flow Temp
Control action > Auto tuning On/Off Off
Control action > Loop number 1 or 2 1
Control action > Control mode Off, Single, Cascade, or PVSwitching, or Single

Analog retransmission
Control action > Control mode > Method Range, PVHigh, or Signal Range
Control action > Program control On/Off Off
Control action > PID control mode Follow-up or Fixed-point Follow-up
* Fixed to 1 s for A/D integral time of 100 ms.
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<#2 Input setting>

Parameter Selectable Range or Selections Initial Value

Input setting > Loop number 1 or 2 1
Input setting > Burnout > Measure1 Off, Up, or Down Up
Input setting > Burnout > Measure2 Off, Up, or Down Up
Input setting > Burnout > Remote Off, Up, or Down Up
Input setting > RJC > Measure1 External or  Internal Internal
Input setting > RJC > Measure1 > Volt (uV) –20000 to 20000 µV 0 µV
Input setting > RJC > Measure2 External or  Internal Internal
Input setting > RJC > Measure2 > Volt (uV) –20000 to 20000 µV 0 µV
Input setting > RJC > Remote External or  Internal Internal
Input setting > RJC > Remote > Volt (uV) –20000 to 20000 µV 0 µV

<#3 DI/DO/SW Registration>

Parameter Selectable Range or Selections Initial Value

Contact input > Module CTRL1-DI, CTRL1-DO, INT-SW1, INT-SW2, CTRL1-DI
INT-SW3

Contact input > DI001 to 006 None, AllControlStop, None
Contact input > DO001 to 006 AllControlStart, ControlStart/Stop (1 or 2),
Contact input > SE001 to 018 Remote/Local (1 or 2), Auto/Man (1 or 2),

Cascade (1-2),  Auto1-2,
Man1-2, SPNumber0 to 3 bit,
PVSwitching1 or 2, MemoryStart/Stop,
Trigger, AlarmAck, TimeAdjust,
MathStart/Stop, MathReset, ManualSample,
Panel1Load to Panel3Load, Message1 to 8,
Snapshot

<#4 AUX (Alarm mode...)>

Parameter Selectable Range or Selections Initial Value

AUX > Loop number 1 or 2 1
AUX > Remote setting Off or Remote Off
AUX > Alarm mode ALWAYS, STOP, or STOP/MAN ALWAYS
AUX > SP No. selection source 1 or 2 On/Off 1: On, 2: Off
AUX > PV/SP math On/Off Off
AUX > CLOG error Error, Skip Error

<#5 Output processing>

Parameter Selectable Range or Selections Initial Value

Output processing > Loop number 1 or 2 1
Output processing > Control output Relay, Voltage-pulse, Current-output, Current-output

or On/Off-control
Output processing > Cycle time 1 s to 1000 s 30 s
Output processing > Analog-output type 4-20 mA, 0-20 mA, 20-4 mA, or 20-0 mA 4-20 mA

<#6 Relay>

Parameter Selectable Range or Selections Initial Value

Relay > FAIL On/Off Off
Relay > Self diagnosis On/Off Off
Relay > DO001 to 006 De_energize/Hold, De_energize/Nonhold, Energize/Nonhold

Energize/Hold, or Energize/Nonhold

List of Parameters
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<#7 Tuning setting>

Parameter Selectable Range or Selections Initial Value

Tuning setting > Loop number 1 or 2 1
Tuning setting > 01 to 21 On/Off 01-12: On, 13-21: Off
Tuning setting > 01 to 21 > Item ID SP, A1, A2, A3, A4, P, 01: SP, 02: A1, 03: A2,

I, D, OH, OL, MR, PO, H, DR 04: A3, 05: A4, 06: P,
, BS1, FL1, BS2, FL2, RT, RBS, 07: I, 08: D, 09: OH,
RFL, or W01 to W12 10: OL, 11: MR,

12: PO, 13 to 21: –
Tuning setting > 01 to 21 > Item name Up to 6 alphanumeric characters 01-12: Same as Item ID

13-21: –

<#8 External loop setting>

Parameter Value or Selections Initial Value

#1 Basic setting
Loop number Ext1 to Ext4 Ext1
Comm. Off/On On/Off Off
Modbus address 1 to 247 1
Connecting model UT320, UT321, UT350, UT351, UT420, UT450, UT520, UT550, UT320

UT750, or Others
Loop select First or Second First
Tag Up to 8 alphanumeric characters EXT-01
Tag comment Up to 8 alphanumeric characters –
Auto reading Execute Execute
PV > Decimals 0 to 4 0
PV > Unit Up to 6 alphanumeric characters –
SP > Decimals 0 to 4 0
SP > Unit Up to 6 alphanumeric characters –
OUT > Decimals 0 to 4 0
OUT > Unit Up to 6 alphanumeric characters %
Control span lower –30000 to 30000, span width: 30000 0
Control span upper –30000 to 30000, span width: 30000 10
Control mode SingleLoopControl, CascadePrimaryLoop, CascadeSecondaryLoop, SingleLoopControl

CascadeControl, ControlBackup, PVSwitching, PVAutoSelector,
PVHoldFunction, DualLoopControl, Temperature-Humidity,
Cascade-2Uni, PVSwitching-2Uni, PVAutoSelector-2Uni, or
CustomComputation

Control output Relay, Voltage-pulse, Current-output, or On/Off-control Relay
Alarm Off, PH-H-E (PV high-limit alarm (energize)), Off

PV-L-E (PV low-limit alarm (energize)),
Dev-H-E (Deviation high-limit alarm (energize)),
Dev-L-E (Deviation low-limit alarm (energize)),
Dev-H-D (Deviation high-limit alarm (deenergize)),
Dev-L-D (Deviation low-limit alarm (deenergize)),
Dev-HL-E (Deviation high & low limit alarm (energize)),
D-W-HL-E (Deviation within high & low limits alarm (energize)),
PV-H-D (PV high-limit alarm (deenergize)),
PV-L-D (PV low-limit alarm (deenergize)),
PV-H-ES (PV high-limit alarm (energize/hold)),
PV-L-ES (PV low-limit alarm (energize/hold)),
Dev-H-ES (Deviation high-limit alarm (energize/hold)),
Dev-L-ES (Deviation low-limit alarm (energize/hold)),
Dev-H-DS (Deviation high-limit alarm (deenergize/hold)),
Dev-L-DS (Deviation low-limit alarm (deenergize/hold)),
Dev-HL-ES (Deviation high & low limit alarm (energize/hold)),
D-W-HL-ES (Deviation within high & low limits alarm (energize/hold)),
PV-H-DS (PV high-limit alarm (deenergize/hold)),
PV-L-DS (PV low-limit alarm (deenergize/hold)),
TimeUp1 (Timer, upward detection, hours & minutes),
TimeDown1 (Timer, downward detection, hours & minutes),
TimeUp2 (Timer, upward detection, minutes & seconds),
TimeDown2 (Timer, downward detection, minutes & seconds),
Sensor (Sensor grounding alarm),
Prog-Diag (Self diagnosis output), FAIL (FAIL output),
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Parameter Value or Selections Initial Value

SP-H (SP high-limit), SP-L (SP low-limit),
Out-H (Output high-limit), Out-L (Output low-limit),
Burnout1 (Heater burnout alarm 1), or
Burnout2 (Heater burnout alarm 2),

#2 Parameter address setting
Loop number Ext1 to Ext4 Ext1
PV: Input 30001 to 39999, 300001 to 365535, 40003

40001 to 49999, or 400001 to 465535
SP : Setting 30001 to 39999, 300001 to 365535, 40004

40001 to 49999, or 400001 to 465535
OUT: Output 30001 to 39999, 300001 to 365535, 40005

40001 to 49999, or 400001 to 465535
Control mode 30001 to 39999, 300001 to 365535, 40008

40001 to 49999, or 400001 to 465535
Remote/Local 30001 to 39999, 300001 to 365535, 40008

40001 to 49999, or 400001 to 465535
Operation STOP/RUN 30001 to 39999, 300001 to 365535, 40205

40001 to 49999, or 400001 to 465535
Alarm status 30001 to 39999, 300001 to 365535, 40011

40001 to 49999, or 400001 to 465535
SP number 30001 to 39999, 300001 to 365535, 40010

40001 to 49999, or 400001 to 465535
PID number 30001 to 39999, 300001 to 365535, 40009

40001 to 49999, or 400001 to 465535
Auto reading 30001 to 39999, 300001 to 365535, 40008

40001 to 49999, or 400001 to 465535

#3 Tuning setting
Tuning setting > Loop number Ext1 to Ext4 Ext1
Tuning setting > 01 to 21 On/Off Off
Tuning setting > Item ID SP, A1, A2, A3, A4, P, I, D, OH, OL, MR, H, DR, ETC

DB, PO, or ETC
Tuning setting > Item name Up to 6 alphanumeric characters ETC
Tuning setting > Register address 30001 to 39999, 300001 to 365535, 40001

40001 to 49999, 400001 to 465535
Tuning setting > Decimal point 0 to 4 0
Tuning setting > Range lower –30000 to 30000, span width: 30000 0
Tuning setting > Range upper –30000 to 30000, span width: 30000 10

Setting mode (Control)
#1 Control input range

Parameter Selectable Range or Selections Initial Value

Input range > Loop number 1 or 2 1
Input range > Input type PV1, PV2, RemoteSP, or PVrange PV1
Input range > Mode TC, RTD, Scale, or 1-5V TC
Input range > Type DCV, TC, or RTD TC
Input range > Range TC: R/S/B/K/E/J/T/N//W/L/U/PLATI/PR/WRe K

RTD: PT/JPT
DCV: 20mV, 60mV, 200mV, 2V, 6V, 20V, or 50V

Input range > Span lower-limit Within the range of Range –200.0
Input range > Span upper-limit Within the range of Range 1370.0
Input range > PV range –30000 to 30000 Lower: 0.0,  Upper: 2000.0
Input range > PV switching Lower limit –30000 to 30000 0.0
Input range > PV switching Upper limit –30000 to 30000 2000.0
Input range > Scale –30000 to 30000 Lower: 0.00, Upper: 200.00
Input range > Unit Up to 6 alphanumeric characters –
Input range > Square root On/Off Off
Input range > Low-cut 0.0% to 5.0% 1.0%
Input range > Bias On/Off Off

Selectable range when On: EUS (–100.0% to 100.0%) of 0.0%
the measurement span

Input range > Filter On/Off Off
1 s to 120 s 1 s

Input range > Ratio On/Off Off
Selectable range when On: 0.001 to 9.999 1.000
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#2 Control alarm

Parameter Selectable Range or Selections Initial Value

Alarm > Loop number 1 or 2 1
Alarm > 1 to 4 On/Off Off
Alarm > Type PV-H (PV high-limit), PV-L (PV low-limit), PV-High

Dev-H (deviation high-limit), Dev-L (deviation low-limit),
Dev-H&L (deviation high & low limit),
D-W-H&L (deviation within high & low limits),
SP-H (SP high-limit), SP-L (SP low-limit),
Out-H (Output high-limit), or Out-L (Output low-limit)

Alarm > Standby On/Off Off
Alarm > Relay output On/Off Off
Alarm > Number DO001 to DO006 or SW001 to SW018 DO001
Alarm > SP number 1 to 8 1
Alarm > Alarm value1 to 4 PV high/low limits: EU (0 to 100%) of measurement span, 1370.0

SP high/low limits: EU (0 to 100%) of measurement span,
Deviation high/low limits: EUS (–100 to 100%) of measurement span,
Deviation high & low limit and
deviation within high & low limits: EUS (0 to 100%) of measurement
span, or Output high/low limit: –5.0 to 105.0%

#3 Operation-related parameter/zone PID

Parameter Selectable Range or Selections Initial Value

Operation related/zone PID > Loop number 1 or 2 1
Operation related/zone PID > Suppressing function Off or Overshoot Off
Operation related/zone PID > Ramp-rate time unit Hour, Minute, or Second Hour
Operation related/zone PID > SP ramp-down-rate On/Off Off

Selectable range when On: 1digit to EUS (100.0%) 1570.0
of the measurement span

Operation related/zone PID > SP ramp-up-rate On/Off Off
Selectable range when On: 1digit to EUS (100.0%) 1570.0
of the measurement span

Operation related/zone PID > Tag Up to 8 alphanumeric characters INT-01
Operation related/zone PID > Tag comment Up to 8 alphanumeric characters –
Operation related/zone PID > Reference point EU (0.0 to 100.0%) of the measurement span 1370.0
Operation related/zone PID > Switching hysteresis EU (0.0 to 100.0%) of the measurement span 7.8
Operation related/zone PID > Reference deviation On/Off Off

Selectable range when On: 1digit to EUS (100.0%) 7.8
of the measurement span

#4 PID parameters

Parameter Selectable Range or Selections Initial Value

PID parameters > Loop number 1 or 2 1
PID parameters > PID Number 1 to 8 1
PID parameters > Target setpoint EU (0% to 100%) of the measurement span –200.0
PID parameters > Proportional band(P) 0.1% to 999.9% 5.0%
PID parameters > Integral time(I) 0 s to 6000 s 240 s
PID parameters > Derivative time(D) 0 s to 6000 s 60 s
PID parameters > Output lower limit –5.0% to 105.0% 0.0%
PID parameters > Output upper limit –5.0% to 105.0% 100.0%
PID parameters > Shutdown On/Off Off
PID parameters > Manual reset –5.0% to 105.0% 50.0%
PID parameters > Relay hysteresis > Value EUS (0.0 to 100.0%) of the measurement span 7.8
PID parameters > Relay hysteresis > Position Mid, High, or Low Mid
PID parameters > Reverse/Direct Reverse or Direct Reverse
PID parameters > Preset output –5.0% to 105.0% 0.0%
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#5 Control group setting

Parameter Selectable Range or Selections Initial Value

Control group > Group number 1 to 4 1
Control group > Group name Up to 16 alphanumeric characters CONTROL GROUP1
Control group > 1 to 4 On/Off 1/2: On, 3/4: Off
Control group > 1 to 4 > Kind Int-Loop, Ext-Loop, or Meas-CH Int-Loop
Control group > 1 to 4 > Number Int-Loop: 01 or 02 1: 01, 2: 02

Ext-Loop: 01 to 04
Meas-CH: 01 to 06

#6 Ten-segment linearizer I/O

Parameter Selectable Range or Selections Initial Value

Ten-segment linearizer I/O > Loop number 1 or 2 1
Ten-segment linearizer I/O > Input type PV1 or PV2 PV1
Ten-segment linearizer I/O > Mode Off, Biasing, or Approximation Off
Ten-segment linearizer I/O > Input 1 to 11 Linearizer bias: EU (–5.0% to 105.0%) of 1: –200.0, 2: 1370.0,

the measurement span 3 to 11: –200.0
Linearizer approximation: EU (–5.0% to 105.0%) of
the measurement span

Ten-segment linearizer I/O > Output 1 to 11 Linearizer bias: EUS (–100.0% to 100.0%) of 0.0
the measurement span
Linearizer approximation: EU (–5.0% to 105.0%) of
the measurement span

#7 Program control related (only when program control is ON)
<#1 Program parameter setting>

Parameter Selectable Range or Selections Initial Value

#1 Pattern initial setting
Program initial setting > Pattern number 1 to 4 (/PG1), 1 to 30 (/PG2) 1
Program initial setting > Segments 0 to 99 0
Program initial setting > Segment setting method Time, Ramp Time
Program initial setting > Pattern name Up to 16 alphanumeric characters Pattern 1

#2 Wait action setting
Wait action setting > Wait zone 1 to 5 > Loop 1,  2 On/Off Off
 > H, L EUS (100.0%) of the measurement span 1 digit
Wait action setting > Wait time 00:00:00 to 99:59:59 00:00:00

#3 Pattern start setting
Pattern start setting > Start target setpoint > Loop 1,  2EU (0% to 100%) of the measurement span –200.0
Pattern start setting > Start code StartTargetSP, RampPV1 to RampPV6, TimePV, StartTargetSP

#4 Program pattern setting
Program pattern setting > Segment number 1 to specified number of segments 1
Program pattern setting > Ramp/Soak select Ramp, Soak Ramp
Program pattern setting > Target setpoint > Loop 1,  2 EU (0% to 100%) of the measurement span –200.0
Program pattern setting > Segment time1 00:00:00 to 99:59:59 00:00:01
Program pattern setting > Ramp-rate time unit2 Hour, Minute Hour
Program pattern setting > Ramp2 1 digit to EUS (100.0%) of the measurement span 1 digit
Program pattern setting > Segment PID group No. 1 to specified PID number 1
Program pattern setting > Segment shift action Continue, HoldShift, LocalShift, ResetShift Continue
Program pattern setting > Wait action Off, Shift, Within Off
Program pattern setting > Wait zone number 1 to 5 1
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Parameter Selectable Range or Selections Initial Value

#5 Event setting
Event setting > Segment number 1 to specified number of segments 1
Event setting > Event kind PVEvent, TimeEvent TimeEvent
Event setting > Event No. 1-8, 9-16 1-8
Event setting > TimeEvent 1 to 16 On1, On2, On3, Off Off
Event setting > TimeEvent 1 to 16 > On-time, Off-time 00:00:00 to 99:59:59 00:00:00
Event setting > PVEvent 1 to 16> Loop Off, 1 to 6 Off
Event setting > PVEvent 1 to 16 > Loop > Type PV-High, PV-Low, Deviation-High, Deviation-Low, PV-High

Deviation-H&L, Dev-within-H6L, SP-High, SP-Low,
Output-High, Output-Low

Event setting > PVEvent 1 to 16 > Loop > Value PV:  EU (0% to 100%) of the measurement span 1370.0
Deviation:  EUS (0% to 100%) of the measurement span 1570.0
SP:  EU (0% to 100%) of the measurement span 1370.0
Output:  -5.0 % to 105.0 % 105.0 %

#6 Event output setting
Event output > Event kind PVEvent, TimeEvent TimeEvent
Event output > Relay Output EV1 to 16 On, Off Off
Event output > On EV1 to 16 > Number DO001 to DO006, SW001 to SW018 DO001
Program pattern end signal > Relay Output On, Off Off
Program pattern end signal > On > Number DO001 to DO006, SW001 to SW018 DO001

#7 Hysteresis (PV event)
Hysteresis (PV event) > PV event > 0.0% to 10.0 0.5%
Hysteresis 1 to 16

#8 Repeat action setting
Repeat action setting > Repeat action Off, On, Repeat Off
Repeat action setting > On > Repeat frequency 1 to 999 1
Repeat action setting > Repeat action 1 to specified number of segments 1
 > Repeat start segment
Repeat action setting > Repeat action 1 to specified number of segments 1
 > Repeat end segment
1 When [Time] is specified for the segment setting method.
2 When [Ramp] is specified for the segment setting method.

<#2 Event output setting>

Parameter Selectable Range or Selections Initial Value

Event output > Event kind PVEvent, TimeEvent TimeEvent
Event output > Relay (EV1 to 16) On/Off Off
Event output > On (EV1 to 16) > No. DO001 to DO006 DO001
Program end signal On/Off Off
Program end signal > On DO001 to DO006 DO001

<#2 AUX (Auto message, Display position)>

Parameter Selectable Range or Selections Initial Value

AUX (Auto message, Display position) > On, Off On
Auto message for program Run/Reset On/Off
AUX (Auto message, Display position) > 1 or 2 Loop 1, 2: 1, 2
Program display position > Position > Loop 1 to 6
AUX (Auto message, Display positin) > On, Off Off
Auto change to program run display

<#3 AUX (Event group)>

Parameter Selectable Range or Selections Initial Value

AUX (Event group) > Pattern number 1 and 2 1
AUX (Event group) > 1 to 5 On, Off On
AUX (Event group) > On 1 to 5 > Kind PVEvent, TimeEvent Time Event
AUX (Event group) > Number 01 to 05 1 to 5: 01 to 05
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#8 Detailed settings (#7 when the program control function is OFF)
<#1 Control function>

Parameter Selectable Range or Selections Initial Value

Control function > Loop number 1 or 2 1
Control function > SP Tracking Off/On On
Control function > PV tracking On/Off Off
Control function > Target setpoint limiter > Lower EU (0.0% to 100.0%) of the measurement span –200.0
Control function > Target setpoint limiter > Upper EU (0.0% to 100.0%) of the measurement span 1370.0
Control function > Output velocity limiter On/Off Off

Enter the value for On: 0.1%/s to 100.0%/s 100.0%/s
Control function > Anti-reset windup Auto or Manual Auto

Enter the value for Manual: 50.0% to 200.0% 100.0%

<#2 Hysteresis (Alarm)>

Parameter Selectable Range or Selections Initial Value

Hysteresis (Alarm) > Alarm > Loop number 1 or 2 1
Hysteresis (Alarm) > Alarm > Hysteresis1 to 4 EUS (0.0% to 10.0%) of the measurement span 7.8

<#3 DIO monitor and operation setting>

Parameter Selectable Range or Selections Initial Value

DIO monitor and operation setting > 01 to 12 01
DIO entry number
DIO monitor and operation setting > On/Off On, Off Off
DIO monitor and operation setting > Kind DI-1, DO-1, DO-2, DIO-11, DIO12, DO-2P, DI-1

DIO-12P
DIO monitor and operation setting > SW number SW001 to SW018 SW001
DIO monitor and operation setting > DO number > DO001 to DO006 DO001
ON
DIO monitor and operation setting > DO number > DO001 to DO006, DO001
 OFF
DIO monitor and operation setting > DI number DI001 to DI006 DI001
DIO monitor and operation setting > Tag Up to 8 alphanumeric characters –
DIO monitor and operation setting > Tag comment Up to 8 alphanumeric characters –
DIO monitor and operation setting > Up to 8 alphanumeric characters –
Operation property >ON > Label
DIO monitor and operation setting > Red, green, blue, blue violet, brown, orange, yellow-green, Red
Operation property >ON > Color light blue, violet, gray, lime, cyan, dark blue, yellow,

light gray, or purple
DIO monitor and operation setting > Up to 8 alphanumeric characters –
Operation property >OFF > Label
DIO monitor and operation setting > Red, green, blue, blue violet, brown, orange, yellow-green, Red
Operation property >OFF > Color light blue, violet, gray, lime, cyan, dark blue, yellow,

light gray, or purple

<#4 DI/DO label setting>

Parameter Selectable Range or Selections Initial Value

DI/DO label setting > Module CTRL1-DI, CTRL1-DO CTRL1-DI
DI/DO label setting > DI001 to DI006 > Label Up to 16 alphanumeric characters DI001 to DI006
DI/DO label setting > DO001 to DO006 > Label Up to 16 alphanumeric characters DO001 to DO006
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#9 Detailed settings (#8 when the program control function is OFF)
<#1 PV/SP math, Retransmission>

Parameter Selectable Range or Selections Initial Value

PV/SP math, Retransmissin > Loop number 1 or 2 1
PV/SP math, Retransmissin > PV/SP PV, PV1, pV2, SP Value depending on the

(Depending on the control mode) control mode
PV/SP math, Retransmissin > Mode On/Off Off
PV/SP math, Retransmissin > Up to 120 alphanumeric characters Previously determined
Calculation expression control input channel No.
PV/SP math, Retransmissin > PV range > -30000 to 30000 (upper-lower ≤ 30000) Measurement range
Lower-limit of calcuration expression

initial vlue
PV/SP math, Retransmissin > PV range > -30000 to 30000 (upper-lower ≤ 30000) Measurement range
Upper-limit of calcuration expression

initial vlue
PV/SP math, Retransmissin > Unit Up to 6 alphanumeric characters –
PV/SP math, Retransmissin > PV swithing > Lower -30000 to 30000 (upper-lower ≤ 30000) Lower limit of PV range
PV/SP math, Retransmissin > PV swithing > Upper -30000 to 30000 (upper-lower ≤ 30000) Upper limit of PV range
PV/SP math, Retransmissin > Math error Over, Under Over

<#2 Logic math>

Parameter Selectable Range or Selections Initial Value

Logic math > Setting number 1-6, 7-12 1-6
Logic math > Relay Off, DO001 to DO006, SW001 to SW018 Off
Logic math > Calculation expression Up to 120 alphanumeric characters –

<#3 Constant>

Parameter Selectable Range or Selections Initial Value

Constant > W01 to W12 –9.9999E+29 to –1.0000E–30, 0, 1
1.0000E–30 to 9.9999E+29

Set mode
#1 Range, Alarm

Parameter Selectable Range or Selections Initial Value

First-CH 01 to 06 01
Last-CH 01 to 06 01
Range > Mode Volt, TC, RTD, Scale, Delta, DI, Sqrt, or Skip Volt
Range > Range 20 mV, 60 mV, 200 mV, 2 V, 6 V, 20 V, 50 V, 2 V

R, S, B, K, E, J, T, N, W, L, U, PLATI, PR, Wre,
PT, JPT, Level, or Cont

Range > Span Lower – –2.000
Range > Span Upper – 2.000
Alarm > 1 to 4 On/Off Off
Alarm > Type H: High limit, L: Low limit, R: Rate-of-change, H

T: Delay high, t: Delay low
Alarm > Value – 0.000
Alarm > Relay On/Off Off
Alarm > Relay Number I01 to I06, DO001 to DO006, or SW001 to SE018 I01
Alarm > Detect On/Off On

#2 Tag, Moving average, Alarm delay time

Parameter Selectable Range or Selections Initial Value

First-CH 01 to 06, 101 to 106, or 201 to 212 01
Last-CH 01 to 06, 101 to 106, or 201 to 212 01
Tag Up to 16 alphanumeric characters 01
Moving average > Count Off, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12, 13, 14, 15, or 16 Off
Alarm delay > Time 1 s to 3600 s 10 s
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#3 Trend/Save interval, User key

Parameter Selectable Range or Selections Initial Value

Trend/Save interval > Time/div 1 min, 2 min, 5 min, 10 min, 20 min, 30 min, 1 h, 2 h, 4 h, or 10 h 1 min
Trend/Save interval > Auto save interval 10 minutes to 31 days 1 h
USER key > Action None, Trigger, AlarmACK, MathStart/Stop, MathReset, AlarmACK

ManualSample, Message1 - Message8, or Snapshot

#4 Message

Parameter Selectable Range or Selections Initial Value

Message > Characters No. 1 to No. 8 Up to 16 alphanumeric characters –

#5 Display
<#1 Group set, Trip line>

Parameter Selectable Range or Selections Initial Value

Group number 1 to 6 1
Group set > Group name Up to 16 alphanumeric characters GROUP 1
Group set > CH set 01 to 06, 101 to 106, or 201 to 212 01-06
Group set > Trip line > No. 1 to No. 4 On/Off Off
Group set > Trip line > Position 0% to 100% 100%
Group set > Trip line > Color Red, green, blue, blue violet, brown, orange, yellow-green, light blue, No.1: Red, No.2: Green,

violet, gray, lime, cyan, dark blue, yellow, light gray, or purple No.3: Blue, No.4: Yellow

<#2 Color>

Parameter Selectable Range or Selections Initial Value

Color > CH1 Red, green, blue, blue violet, brown, orange, yellow-green, light blue, Red
violet, gray, lime, cyan, dark blue, yellow, light gray, or purple

Color > CH2 Same as above Green
Color > CH3 Same as above Blue
Color > CH4 Same as above Blue-violet
Color > CH5 Same as above Brown
Color > CH6 Same as above Orange

<#3 Zone, Graph, Partial>

Parameter Selectable Range or Selections Initial Value

First-CH 01 to 06 01
Last-CH 01 to 06 01
Zone > Lower 0% to 95% 0%
Zone > Upper 5% to 100% 100%
Graph > Division 4, 5, 6, 7, 8, 9, 10, 11, 12, or C10 10
Graph > Bar graph Normal or Center Normal
Graph > Scale position Off or 1 to 6 1
Partial On/Off Off
Expand 1% to 99% 50%
Boundary Minimum span value + 1 digit to maximum span value – 1 digit (for channels –

set to a range other than scale or square root computation) or
minimum scale value + 1 digit to maximum scale value – 1 digit (for channels
set to scale or square root computation)

<#4 View, Direction, LCD>

Parameter Selectable Range or Selections Initial Value

View > Direction > Trend Horizontal, Vertical, or Horizon2 Vertical
View > Direction > Bar graph Horizontal or Vertical Vertical
View > Background > Measure White or Black White
View > Background > Control White or Black Black
View > Trend line 1, 2, or 3 dots 2 dots
View > Trip line 1, 2, or 3 dots 2 dots
View > Grid Auto, 4 div, 5 div, 6 div, 7 div, 8 div, 9 div, 10 div, 10 div

11 div, or 12 div
View > Scroll 5 s, 10 s, 20 s, 30 s, 1 min 5s
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arameter Selectable Range or Selections Initial Value

View > Scale digit Normal or Fine Normal
LCD > Brightness 1 to 8 4
LCD > Backlight saver > On/Off On/Off Off
LCD > Backlight saver > Saver time 1 min, 2 min, 5 min, 10 min, 30 min, or 1 h 1 h
LCD > Restore Key or Key+Alm Key+Alm

<#5 Control (Color)>

Parameter Selectable Range or Selections Initial Value

Select Internal or External Internal
CH101 Red, green, blue, blue violet, brown, orange, Red

yellow-green, light blue, violet, gray,
lime, cyan, dark blue, yellow, light gray, or purple

CH102 Same as above Green
CH103 Same as above Blue
CH104 Same as above Blue-violet
CH105 Same as above Brown
CH106 Same as above Orange

<#6 Control (Zone, Graph, Partial>

Parameter Selectable Range or Selections Initial Value

First-CH 101 to 106 or 201 to 212 101
Last-CH 101 to 106 or 201 to 212 101
Zone Lower 0% to 95% 0%
Zone Upper 5% to 100% 100%
Graph > Division 4, 5, 6, 7, 8, 9, 10, 11, 12, or C10 10
Graph > Bar graph Normal or Center Normal
Graph > Scale position Off or 1 to 10 1
Partial On/Off Off
Expand 1% to 99% 50%
Boundary Minimum span value + 1 digit to maximum span value – 1 digit (for channels 0.1

set to a range other than scale or square root computation) or
minimum scale value + 1 digit to maximum scale value – 1 digit (for channels
set to scale or square root computation)

<#7 Math (Color)>

Parameter Selectable Range or Selections Initial Value

CH31 Red, green, blue, blue violet, brown, orange, Red
yellow-green, light blue, violet, gray,
lime, cyan, dark blue, yellow, light gray, or purple

CH32 Same as above Green
CH33 Same as above Blue
CH34 Same as above Blue-violet
CH35 Same as above Brown
CH36 Same as above Orange
CH37 Same as above Yellow-green
CH38 Same as above Light blue
CH39 Same as above Violet
CH40 Same as above Gray
CH41 Same as above Lime
CH42 Same as above Cyan
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<#8 Math (Zone, Graph, Partial>

Parameter Selectable Range or Selections Initial Value

First-CH 31 to 42 31
Last-CH 31 to 42 31
Zone > Lower 0% to 95% 0%
Zone > Upper 5% to 100% 100%
Graph > Division 4, 5, 6, 7, 8, 9, 10, 11, 12, or C10 10
Graph > Bar graph Normal or Center Normal
Graph > Scale position 1 to 10 or Off 1
Partial On/Off Off
Expand 1% to 99% 50%
Boundary Minimum span value + 1 digit to maximum span value – 1 digit (for channels 0.00

set to a range other than scale or square root computation) or
minimum scale value + 1 digit to maximum scale value – 1 digit (for channels
set to scale or square root computation)

#6 File, DST

Parameter Selectable Range or Selections Initial Value

File > Header Up to 32 alphanumeric characters –
File > Directory name Up to 8 alphanumeric characters DATA0
File > Save data Unsave or All All
Daylight saving time (YY/MM/DD HH) > Summer Off/On Off
Daylight saving time (YY/MM/DD HH) > Winter Off/On Off

#7 Save/Load, Clear data

Parameter Selectable Range or Selections Initial Value

#1 Save settings – –
#2 Load settings – –
#3 Save data – –
#4 Load display data – –
#5 Load event data – –
#6 File list – –
#7 Delete – –
#8 Format – –
#9 Clear data – –

#8 Time

Parameter Selectable Range or Selections Initial Value

Time set – –

#9 Math set1 (expression, alarm)

Parameter Selectable Range or Selections Initial Value

First-CH 31 to 42 31
Last-CH 31 to 42 31
Math range > Math On/Off On/Off Off
Math range > Calculation expression 40 characters or less. 01
Math range > Span Lower –9999999 to 99999999 (decimal point: within 4 digits to –200.00

the right of the decimal point)
Math range > Span Upper –9999999 to 99999999 (decimal point: within 4 digits to 200.00

the right of the decimal point)
Math range > Unit Up to 6 alphanumeric characters –
Alarm > 1 to 4 On/Off Off
Alarm > Type H, L, T, or t H
Alarm > Value Value within the measurement span 0.00
Alarm > Relay On/Off On/Off Off
Alarm > Relay Number I01 to I06 or DO001 to DO006 I01
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#10 Math set2 (constant)

Parameter Selectable Range or Selections Initial Value

Constant > K01 to K12 –9.9999E+29 to –1.0000E–30, 0, 1
1.0000E–30 to 9.9999E+29

#11 Math set3 (tag, TLOG, rolling average, alarm delay)

Parameter Selectable Range or Selections Initial Value

First-CH 31 to 42 31
Last-CH 31 to 42 31
Tag > Tag Up to 16 alphanumeric characters 31
TLOG > Timer No. 1, 2, or 3 1
TLOG > Sum scale Off, /s, /min, or /h Off
Rolling average On/Off Off
Rolling average > Interval 1 s, 2 s, 3 s, 4 s, 5 s, 6 s, 10 s, 12s, 15s, 20s, 30s, 10 s

1 min, 2 min, 3 min, 4 min, 5 min, 6 min, 10 min, 12 min,
15 min, 20 min, 30 min, or 1 h

Rolling average > Number of samples 1 to 64 1
Alarm delay time 1 s to 3600 s 10 s

#12 Batch set

Parameter Selectable Range or Selections Initial Value

Application name Up to 16 alphanumeric characters –
Supervisor name Up to 16 alphanumeric characters –
Manager name Up to 16 alphanumeric characters –
Batch number Up to 16 alphanumeric characters –
Lot number Up to 4 alphanumeric characters
Auto increment On/Off On
Disp information Brtch, Time Batch
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